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Das erste Projekt

Bevor Sie IThr erstes Spiel erstellen kénnen, miissen Sie sich noch ein bisschen
gedulden. Erst einmal machen Sie sich etwas mit der »Maschine« vertraut, mit der
Sie spiter ein Werk »zaubern« wollen, das sich sehen und spielen lisst. Schon hier
beginnen wir mit einem Projekt. Und wir spielen auch schon mal ein bisschen mit
einem Objekt herum.

1.1  Unity starten

Bevor wir mit dem »Basteln« anfangen koénnen, muss das Game-Entwicklungs-
system Unity installiert werden. Wie das geht, steht im Anhang. Danach kann es
direkt losgehen.

Es gibt mehrere Wege, um Unity zu starten. Einer ist dieser:

1. Offnen Sie den Ordner, in den Sie Unity installiert haben (bei mir ist das der
Unterordner UN1Ty HUB im Ordner PrRoGRaMME auf Laufwerk C:).
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Unity Hub X +
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2. Suchen Sie nun unter den vielen Symbolen eines heraus, das wie eine Art
schwarzer Wiirfel aussieht, es muss den Namen Unity hub.exe tragen. Dann
starten Sie das Programm mit einem Doppelklick auf das Symbol.

? e

Unity Unity Hub
Hub.exe

Start-Symbol

Weil wir Unity ja sehr oft starten werden, empfehle ich hier, eine Verkniipfung
auf dem Desktop anzulegen:

m Klicken Sie dazu mit der rechten Maustaste auf das entsprechende Unity-
Symbol (Unity Hub.exe). Im Kontextmenii wihlen Sie KOPIEREN.

B Dann klicken Sie auf eine freie Stelle auf dem Desktop, ebenfalls mit der
rechten Maustaste. Im Kontextmenii wihlen Sie VERKNUPFUNG EINFUGEN.

Es ist sinnvoll, das neue Symbol auf dem Desktop umzubenennen, z.B. von UNI-
TY HUB.EXE — VERKNUPFUNG in einfach nur UNrTy.

Von nun an doppelklicken Sie einfach auf das neue Symbol, und Unity wird
gestartet.

Je nach Computer kann es eine Weile dauern, bis Unity Hub geladen ist. Einige
Zeit spiter erscheint ein neues Fenster:

Unity Hub

He Projects Add ~

Projects

3. Klicken Sie dazu auf NEW PROJECT.
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Unity Hub

All templates

Core
Universal 2D

Sample : Core

Learning
Universal 3D
Core

4. Wihlen Sie im neuen Dialogfeld die Einstellung UNIvERsAL 2D.
Mit 3D beschiftigen wir uns spiter noch ausfiihrlich.

5. Geben Sie dann im Feld fiir ProjecT NAME einen Namen fiir Thr neues Projekt
ein. Bei LocaTIioN sollte der Ordner stehen, in dem das Projekt untergebracht
werden soll (wenn Sie nichts eingeben, schaftt sich Unity seinen eigenen Ord-
ner fur Thre Spielprojekte.)

Ich benutze einen Ordner UNITY und nenne mein erstes Projekt schlicht und ein-
fach ProjExTl.

Projekt1

Location
D:\Unity

Connect to Unity Cloud

Use Unity Version Control

Cancel

6. Klicken Sie zum Abschluss auf CREATE PROJECT.

Es dauert nun eine Weile, bis Thr Projekt in der Liste unter Projects auftaucht.
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Unity Hub

P rOj ects New project

Projects
NAME CLOUD MODIFIED EDITOR VERSION
Installs

Learn i CONNECTED a minute ago

Community

Anschliefend zeigt uns Unity endlich seine Arbeitsumgebung. Schauen wir uns
erst einmal die Aufteilung der wichtigsten Fensterbereiche an:

¥ Projekt1 - SampleScene - Windows, Mac, Linux - Unity 6

File Edit Assets GameObject Component Services Jobs Window Help

Hierarchy: Scene: die aktuelle Spiel-Szene Inspector:
Liste aller Eigenschaften

Objekte der . des aktuell
aktuellen Game: das Spielgeschehen ausgewahlten

Szene Objekts

[Projekt-
Ordner-
Liste]

Project: Anzeige aller Projekt-Dateien

Console: Anzeige von Hinweisen/Fehlern

L

B Im GaMmEe-Fenster ist es erst einmal leer. Da sehen Sie spiter Thr Spiel in Echt-
zeit ablaufen, wenn Sie es durch einen der dartiberliegenden Buttons gestartet
haben.

B Dahinter liegt das Scene-Fenster. Und es gibt auch schon zwei Objekte: Kamera
und Licht. Doch fiir ein Spiel brauchen wir dann noch mindestens ein weiteres
Objekt wie eine Kugel oder eine Figur.
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B Im HierarcHy-Fenster sind bis jetzt nur MaiNn CaAmERA und ggf. GroBaL LigHT
aufgelistet. Dort stehen dann spiter auch alle Objekte, die zur Szene eines
Spiels gehoren (jedes Spiel konnte mehrere Szenen haben).

B Das Project-Fenster erfasst die Ordner mit dem gesamten Zubehor fiir alle
Spielszenen. Dazu gehéren natiirlich u.a. auch Programmteile. Bilder, die Sie
als Spiel-Objekt einsetzen wollen (wie z.B. eine Kugel oder eine Figur), lassen
sich einfach mit der Maus aus einem Ordnerfenster unter Windows hier hi-
neinziehen. Damit wird die entsprechende Datei ins Projekt kopiert.

B Dahinter findet sich das Consore-Fenster, das sich u.a. bei Fehlern meldet. Au-
Rerdem lassen sich dort Daten anzeigen, z.B. von Spiel-Objekten.

B Um sich die Eigenschaften eines Objekts nicht nur anzuschauen, sondern auch
bearbeiten zu konnen, gibt es das INspEcTOR-Fenster. Damit werden wir des
Ofteren zu tun haben.

Schalten Sie mal vom Game-Fenster ins Sceng-Fenster um.

In der Mitte ist das Symbol fiir die Kamera.

¥ Projekt1 - SampleScene - Windows, Mac, Linux - Unity 6

File Edit Assets GameObject Component Services Jobs Window Help

& Unity &

Asset Labels

Wenn Sie im HierarcHY-Fenster auf Main CaMERa klicken, zeigt der INsPECTOR
plétzlich eine ganze Menge an (dndern sollten Sie aber daran nichts).
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Mit dem Hauptmenii bekommen wir immer wieder zu tun. Die Bedeutung der
meisten Mentipunkte kliren wir nach und nach.

# Projekt1 - SampleScene - Windows, Mac, Linux - Unity 6

File Edit Assets GameObject Component Services Jobs Window Help

1.2 Ein Objekt zum Spielen

Wir beginnen mit etwas Einfachem. Dazu brauchen wir eine Kugel, und die soll
sich tiber das Spielfeld bewegen lassen, z.B. mit der Maus oder mit den Tasten.

1. Klicken Sie oben im Hauptmenii auf GAMEOBjECT und dann auf den Eintrag 3D
OpjecT. Im Zusatzmenii bekommen Sie nun eine Auswahl. Klicken Sie auf den
Eintrag SPHERE (= Kugel).

GameObject
Create Empty Ctrl+Shift+N
Create Empty Child Alt+Shift+N
2D Object >
| 3D Object | > Cube
Effects > I Sphere
Light > Capsule
Audio > Cylinder
Video > Plane
Camera Quad
Text - TextMeshPro
Ragdoll...
Terrain
Tree
Wind Zone
3D Text
Ul >

Anschliefend taucht im ScenEe-Fenster etwas auf, das bei genauerem Hinsehen
wie ein Kreis aussieht — aber irgendwie auch recht mickrig. Auflerdem zeigt der
InsPECTOR zahlreiche Informationen iiber unser neues Spiel-Objekt.



1.2
Ein Objekt zum Spielen

Transform

Sphare (Mas' @

Dargestellt sind in der Mitte nun zwei Objekte: die Kamera (auf die wir noch zu
sprechen kommen) und darunter oder dahinter die von uns erzeugte Kugel.

Nun ist es an der Zeit, die ganze Szene schon einmal zu speichern.

2. Klicken Sie auf Fire und Save.

File
New Scene Ctrl+N
Open Scene Ctrl+0
Open Recent Scene >
| Save Ctil+s |
Save As... Ctrl+Shift+S

Save As Scene Template...

New Project...
Open Project...
Save Project

Build Settings... Ctrl+Shift+B
Build And Run Ctrl+B
Exit

SampleScene

In Unity heifit diese Szene zuerst SAMPLESCENE. Passt Thnen der Name nicht,
miissen Sie die Option SAvE As wihlen und im Dialogfeld einen Namen einge-
ben, z.B. KucELl (wenn IThnen nichts Besseres einfillt). Die Kennung Unrty wird
automatisch angefiigt. Dann klicken Sie auf SPEICHERN.
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# Save Scene

<« ~ o « Projekt1 > Assets > Scenes C Scenes durchsuchen P

oo
oo
4

7]

Organisieren ~  Neuer Ordner

& Arbeitsplatz
&= BootDisk (C) @

== WorkDisk (D:) SampleS
== MediaDisk (E:) cene.unit
== SafeDisk (F;) Y

¥ Netzwerk

Dateiname: | Kugel1

Dateityp: unity (*.unity)

 Ordner ausblenden Abbrechen

Wenn Sie anschliefend im Project-Fenster auf Assets klicken, sehen Sie den Ord-
ner SceNEs, darin befindet sich das Symbol fiir die Szenen-Dateien.

Scenes

Bm Scenes Kugell SampleSce.

Bevor wir nun weitermachen, mochte ich Thnen eine Moglichkeit vorstellen, die
bisher dunkle Anzeige auf ein hellere umzustellen.

Suchen Sie im (sehr langen) Epir-Menii nach dem Eintrag PREFERENCES und
klicken Sie darauf.
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Search »
Play Ctrl+P
Pause Ctrl+Shift+P
Step Ctrl+Alt+P
Project Settings...

I Preferences... I
Shortcuts...

Suchen Sie unter GENERAL den Eintrag EpiTor THEME. Dort wihlen Sie LicHT
statt DARK.

® Preferences

o

General

Recompile And Continue Playing
Release
Dark

Dark

Anschlielend ist alles um einiges heller. Wenn es Thnen gefillt, lassen Sie es so.
Oder Sie kehren zuriick zum Dark-Mode.

Ich werde ab jetzt hier im Buch den Light-Mode benutzen, weil die Abbildungen
lesbarer sind. Sie selbst kénnen frei wihlen, ob Sie beim Dark-Mode bleiben oder
auch in den Light-Mode wechseln.

Und nun schauen wir uns die ganze Szene einmal genauer an, und zwar in einem
anderen Fenster.

1. Dazu schalten Sie mit Klick auf den Reiter mit dem Text GaME (direkt rechts
neben dem ScenE-Reiter) die Anzeige um.
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= Hierarchy 2 i f# Scene i
4+ [ Al 7| | Game ~ | Display1 ~ ¥ | Scale =@— 2.5x |Play Focused
¥ &2 Kugell

) Main Camera
Global Light 2D

B Project B console 3 i

Im GamE-Fenster konnen Sie nun etwas sehen. Naja, wie eine Kugel schaut dieser
schwarze Kreis (noch) nicht aus. Aber vielleicht lisst sich daran etwas dndern.

2. Klicken Sie im Hauptmenii auf GaMeOB®jEcT und dann auf LicuT. Im Zusatz-
menii wihlen Sie den Eintrag DIRECTIONAL LIGHT.

GameObject
Create Empty Ctrl+Shift+N
Create Empty Child Alt+Shift+N

Create Empty Parent  Ctrl+Shift+G

2D Object >

3D Object >

Effects >

Light > I Directional Light I
Audio H Point Light

Video 2 Spotlight

Camera Area Light

Center On Children Reflection Probe

Make Parent Light Probe Group

Clear Parent

Set as first sibling Ctrl+=
Set as last sibling Cirl+-
Move To View Ctrl+Alt+F
Align With View Ctrl+Shift+F
Align View to Selected

Toggle Active State Alt+Shift+A
ul >
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Kurz darauf sehen Sie die Kugel in einem anderen Licht. Erkennt man das nur im
GaMmE-Fenster?

= Hierarchy & i # Scene a8 Game i
+~ (oAl @I Game 'I Display1 ~ |Free Aspect ¥ | Scale —@— 2.5x |Play Focused
v @ Kugell* H
f{) Main Camera
) Sphere

(i) GIobaj Light 2D
| [ Directional Light

B Project B Console a i

3. Schalten Sie doch mal um zum Scene-Fenster.

Dort gibt es auch eine Anderung, wie man sehen kann. Das neue Spiel-Objekt wird
als Symbol aus Strahlen dargestellt.

= Hierarchy (=i ' # Scene 'O Game

@ & T Ecenter » @Local ~ || 1 gac-lo o @)~
v i Kugell* H
£ Main Camera
) Global Light 2D
{1 Sphere
| [ Directional Light

B Project B Console =

Nun gibt es ein weiteres Objekt, und es liegt ebenso wie die Kugel in der Fenster-
mitte.
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Licht-Objekte

Wenn Sie wollen, kénnen Sie GrosaLr LicHT auch entfernen: Markieren Sie den
Eintrag und driicken Sie die Taste [Entf].

Toll wire es, wenn sich die Kugel bewegen wiirde. Doch wie kriegen wir sie dazu?
Zuerst einmal sollten wir diesem »Ding« physikalische Eigenschaften geben. Dass
das Objekt aussieht wie eine Kugel, heifdt noch nicht, dass es sich auch wie eine
Kugel aus einem bestimmten Material verhilt.

1. Markieren Sie jetzt im HierarcHy-Fenster (links) den Eintrag SPHERE. Dann
schauen Sie im InspEcTor-Fenster (rechts) nach einem Button mit der Auf-
schrift Abp ComPoNENT und klicken darauf.

‘= Hierarchy & i Scene s Game i @ Inspector 2 £
v ca (@) | @oener~ |@rocaiv |1 BB © © @ Asphere |
—= & v Sphi Static ~
v &2 Kugell* : @ puecs

3 Tag Untagge~  Layer Defaull~

» /. Transform o
» B sphere (MeshFilter) @ 3=
» [ v Mesh Renderer e =

T+

» @ .~ Sphere Collider ]

Default-Material (Materiz @

> Shader Stand~ | Edit.. | =

Add Component I

B Project B Console 2

Ein kleines Kontextmenii 6ffnet sich.

2. Wibhlen Sie den Eintrag Paysics. Und im nichsten Menii klicken Sie auf Ri-

GIDBODY.
(] ] |G ]
Component < Physics
2D Animation > “ |9_Articulation Body =
Audio > || |i§#Box Collider
Effects > ||| 8 Capsule Collider
Event > ||| /8 Character Controller
Layout > | | @Character Joint
Mesh > M| Cloth
Miscellaneous > | Configurable Joint
Navigation > ||| & Constant Force
Physics 2D > ||| Fixed Joint
> W | gl Hinge Joint
Playables > esh Collider
Rendering >
Scripts > & ‘e Collider -
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Ein alternativer Weg fithrt tiber das Hauptmenii: Dazu klicken Sie sich iiber
CoMPONENT und PHYSICS zu RicipBODY durch.

Component

|[ Mesh 2
Effects 5

I Physics > Rigidbody
Physics 2D > Character Controller
Navigation ¢ Box Collider
Audio i Sphere Collider
Video 2 Capsule Collider
R.endering ’ Mesh Collider
Tilemap ’ Wheel Collider
Layout & Terrain Collider
Playables Z
Miscellaneous “ il
Scripts > Hinge Joint
ul > Fixed Joint
Event > Spring Joint
2D Ariitnation > Character Joint
Add... Ctrl+Shift+A Configurable Joint

l Constant Force

Damit bekommt die Kugel (Sphere) einige physikalische Eigenschaften wie Masse
(unsere Kugel wiegt also auf einmal etwas) und Gravitation (sie wird vom Boden
angezogen, wiirde also aus der Luft herunter auf den Boden fallen). Auch Kollisi-
onen mit anderen Objekten und ihre Folgen sind nun mdoglich (ich gehe spiter
genauer auf Einzelheiten ein).

Komponente wieder entfernen?

Falls Sie aus Versehen eine falsche Komponente hinzugefiigt haben: Wie werden
Sie diese wieder los? Schauen Sie im INsPEcTOR-Fenster mal genauer hin. Hinter
jedem Komponenten-Namen sind ganz rechts drei kleine Piinktchen.

Klickt man darauf, 6ffnet sich ein Kontextmenii, in dem u.a. der Eintrag REMOVE
CoMPONENT zu finden ist (aufler bei der TRANsSForRM-Komponente, die lisst sich
nicht entfernen).
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@ Inspector cikt Reset
@ v Sphere Static ~
" Tag Untaggec~ | Layer Defauft -
» A Transform e = Remove Component |
» H . Sphere (Mesh Filter) @ 3t Move Up
» B@ v Mesh Renderer e i ;
» & ~ Sphere Collider o 3t
Copy Component
» @& Rigidbody 0 3|
. Default-Material (Material) @ $
> Shader Stand~ | Edit.. | = ~
Find References In Scene
Add Component Properties...

Spiel-Hierarchie

Wie Sie sicher bemerkt haben, gibt es in Unity diese Hierarchie: Eine Szene um-
fasst mindestens ein Objekt vom Typ GAMEOBJECT. Die Kamera ist ja schon beim
Erzeugen eines Projekts vorhanden. Dazu kommt dann so etwas wie eine Spiel-
figur. In unserem Fall ist das erst mal nur eine Kugel. Die hat dann verschiedene
Komponenten, ebenfalls Objekte, nur vom Typ COMPONENT.

l GameObject ‘ Sphere ‘
L 3 L L 3

‘ Component ‘ ‘ Transform ‘

‘ Component ‘ ‘ Collider ‘

‘ Component ‘ ‘ Rigidbody ‘

Die Komponente TransrorM hat jedes Spiel-Objekt »von Geburt an«. Weitere
Komponenten lassen sich (fast) beliebig hinzufiigen (aber auch wieder entfer-
nen).

Wir sollten das Ganze schon einmal ausprobieren.

1. Wechseln Sie dazu ins Game-Fenster.

# Scene

}Game 'j Display 1 vfFret—."Asptact

2. Dann klicken Sie im Hauptmenii auf EpiT und suchen Sie den Eintrag Pray.
Oder Sie verwenden die Tastenkombination [Strg]+[P].
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Edit
Undo Ctrl+Z
Redo Ctrl+Y
Search >
I Play Ctrl+P I
Pause Ctrl+Shift+P
Step Ctrl+Alt+P
Project Settings...
Preferences...
Shorteuts...

Im ersten Moment passiert anscheinend nichts, dann auf einmal fillt die Kugel
und verschwindet aus dem Spielfeld.

it Scene s Game i
T ‘ Display1 = ‘Free Aspect v| Scale -@— 2x |Play Focused

| Game

Start und Stopp

Start und Stopp eines Unity-Spiels kénnen Sie auch iiber Buttons steuern. Ganz
oben, direkt unter der Meniizeile, finden sich drei davon. Sie erinnern an die
Steuerung z.B. bei Audio-Rekordern.

File Edit Assets GameObject Component Services Jobs Window Help

@umtys @ HS v @ AssetStore ¥ @ : @

= Hierarchy = # Scene an Game
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Das linke (mit dem Dreieck) ist der Pray-Button. Per Mausklick ldsst sich damit
ein Spiel starten und stoppen. Mit dem mittleren Button kénnen Sie das Spiel
auch pausieren und dann weiterlaufen lassen.

1.3 Gravitation und Kollision

Irgendwie muss es nicht sein, dass die Kugel gleich nach dem Start als Spielfigur
aus dem sichtbaren Bereich herausfillt. Damit das nicht passiert, kénnte man die
Gravitation ausschalten.

Andererseits kann die Gravitation einem beim Spielen niitzlich sein. Denken Sie
z.B. an ein Jump & Run-Game. Da geht es ja um Figuren, die springen und rennen,
aber immer wieder irgendwo landen (und dazu brauchen sie die »Erdanziehungs-
kraft«).

Eine andere und bessere Moglichkeit wire es, fiir das Spielfeld eine untere Grenze
zu verwenden. Das kénnte ein Quader sein. Probieren wir’s aus.

1. Klicken Sie im Hauptmenii auf GAMEOBjECT und dann auf 3D OsjecT. Im Zu-
satzmenti suchen Sie diesmal den Eintrag Cusk (= Wiirfel) und klicken darauf.

GameObject
Create Empty Ctrl+Shift+N
Create Empty Child Alt+Shift+N

2D Object >

3D Object > Cube
Effects > Sphere
Light b Capsule
Audio b Cylinder
Video > Plane
Camera Quad

Text - TextMeshPro
Ragdoll...

Terrain
Tree
Wind Zone

3D Text

Ul »
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Im Scene-Fenster hat sich nun uiber den Kreis so etwas wie ein Quadrat gelegt.
Auch hier zeigt der InspEcTOR zahlreiche Informationen tiber das neue Spiel-
Objekt.

= Hierarchy 2 i  # Scene a5 Game

+¥ Al =] || [e1center » E@Local ¥ || |1 »Hv|l e & @ O %~
v it Kugel1* i
) Main Camera
) Sphere
) Cube
{7 Directional Light

I Project B Console 3 i

2. Vielleicht ist es sinnvoll, die Szene erst einmal wieder speichern (mit Klick auf
F1iE und SavE).

Aktuell ist der Quader noch ein Wiirfel, spiter kénnte man daraus eine Platte ma-
chen. Doch erst einmal suchen wir eine Moglichkeit, den Quader nach unten zu
verschieben. Grundsitzlich gibt es da zwei Moglichkeiten:

B Man packt das Objekt im ScenEe-Fenster mit der Maus und zieht es nach unten
(das Ganze geht natiirlich auch in andere Richtungen).
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B Man dndert die Werte fiir PosiTion im INspECTOR-Fenster. Genauer: den y-Wert

auf -1.
@ Inspector 2
@ | Cube ~ Static ~
5 Tag Untagged » | Layer Default =
v .. Transform @ i i
Position X 0 [ -1 k 0
Rotation X 0 S0 O 20
Scale® X 1 1 Z1

+

» H  cube (MeshFilter) e
» B5 v~ Mesh Renderer 2]
» & v/ Box Collider e
Default-Material (Material) @ :
Shader Standa~ Edit.. || = «

+

+

Add Component

3. Sorgen Sie dafiir, dass der Quader direkt unter der Kugel liegt.

4. Und nun kénnen Sie sich im Game-Fenster anschauen, was passiert, wenn Sie
das Spiel starten (damit man mehr sehen kann, habe ich ScatE auf 2,5x einge-
stellt).

Man kann auch mit dem Mauszeiger ins SceNE-Fenster fahren und das Rollrad
der Maus zum Zoomen benutzen.
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# Scene s Game

Game ~ | Display1 ~ |Free Aspect v| Scale —@— 2.5x% |Play Focused

Nichts passiert? Ja und nein. Die Kugel versucht wohl zu fallen, wird aber vom
Quader aufgehalten. Der verhindert, dass hier die Gravitation sichtbar wird. Denn
die Kugel liegt auf dem Quader.

5. Verschieben Sie nun den Quader bis zum Spielfeldrand nach unten. Achten Sie
darauf, dass er moglichst genau unter der Kugel liegt.

1 Scene s Game

|l Blcenter v RLlocalv || 1 syhv| © O @ [° ¥~ |l A vy ® =v v
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Bei mir steht im INsPECTOR-Fenster hinter Position der y-Wert -5. Bei Thnen kann
da nattirlich auch etwas anderes stehen.

Verschiedene Positionen?

Vielleicht haben Sie hin und wieder den Eindruck, dass die Position eines Ob-
jekts im ScenEe-Fenster anders ist als im GamE-Fenster. Das hingt mit der Kame-
ra zusammen. Die allein bestimmt, was im GaMmE-Fenster wo zu sehen ist.

Wenn Sie wollen, konnen Sie die Kamera (MaiN CaMERA) mal anklicken, da-
mit sie markiert ist. Dann lisst sie sich verschieben, ebenso wie eine Kugel oder
ein Quader. Und damit dndert sich auch die Perspektive im Game-Fenster. Uber
Eprr/Unpo oder [Strg]+(7] lisst sich diese Verschiebung wieder riickgingig
machen.

6. Starten Sie das Spiel nun erneut und schauen Sie zu, wie die Kugel fillt und auf
dem Quader landet — eigentlich wie zu erwarten, oder?

# Scene @ Game

| Game v| Display1 ~ | Free Aspect '| Scale -@— 2x |Play Focused ~ | & ‘ " |E \ Stats \Gizmos i

Dass dies keine Selbstverstindlichkeit ist, werden Sie gleich sehen. Verantwortlich
dafiir, dass die Kugel auf dem Quader landet und nicht weiterfillt, ist nicht die
Gravitation, sondern eine andere Eigenschaft, die sie von Anfang an hatte — ebenso
wie der Quader.
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Schauen wir mal ins INspECTOR-Fenster. Dort finden wir unter den Eigenschaften
(auch Komponenten genannt) jeweils einen Sphere-Collider und einen Box-Collider
fiir Kugel beziehungsweise Quader.

@ Inspector 2 ® Inspector 2l
8 v Sphere Static ~ 8 v Cube Static v

- Tag Untagged » Layer Default ~ 3 Tag Untagged = | Layer Default «
» ). Transform e » J.  Transform e

T+
T+

» B sphere (Mesh Filter) » B Cube (Mesh Filter)

o o
S ~ Mesh Renderer @ 3 » E§ v Mesh Renderer 2]
v[® 1 sphere CulllderJ 0 3 v[@ - Boxcoliider | e

T
£

T+

Edit Collider e Edit Collider VY
Is Trigger Is Trigger
Provides Contacts Provides Contacts
Material None (Physics M @ Material None (Physics M @
Center Center
X |0 Y 0 Z 0 X 0 iYa 0 Z 0
Radius 0.5 Size
» Layer Overrides el 1 1 21
> & Rigidbody e = » Layer Overrides
Default-Material (Material) @ ’ Default-Material (Material) @ :
> Shader Standé~ | Edit... || = » » Shader |Standev | Edit.. || &= ~
Add Component Add Component

Kollisionslos

Machen wir mal einen Test: Wenn Sie das Hikchen vor einem dieser beiden
Eintrige entfernen und dann das Spiel erneut starten — z.B. mit dem Play-Button
(oder tiber EpiT und P1ay), dann kénnen Sie beobachten, dass die Kugel nun
einfach durch den Quader hindurchfillt, ein Objekt ist fiir das andere sozusagen
»Luft«.

Collider

Was ist ein Collider? Das hat etwas mit Kollision zu tun. Wenn zwei Objekte auf-
einandertreffen, dann spricht man von einer Kollision. Das kann eine sanfte oder
eine harte Kollision sein. Das Verhalten bei einer solchen »Begegnung« wird in
Unity tiber Collider gesteuert.

Alle betroffenen Objekte miissen also Collider haben. Dabei hat nicht jedes Objekt
den gleichen Collider-Typ. Jeder Collider lisst sich aktivieren und deaktivieren. Das
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ist niitzlich, denn manchmal soll keine Kollision stattfinden, dann lassen sich die
Collider ausschalten.

1.4 2D oder 3D?

Halten wir jetzt erst einmal inne und schauen uns im INsPECTOR-Fenster mal ge-
nauer um. Und zwar auf das, was unter TRaNsrorM steht. Ich habe das in einer
Tabelle zusammengefasst. So sieht es fiir ein Objekt aus, das gerade erzeugt wurde:

X Y Z Mégliche Aktion
PosITION 0 0 0 Verschieben
RoTaTiON 0 0 0 Drehen
SCALE 1 1 1 Grofle dndern

Es gibt hier drei Méglichkeiten, etwas mit einem Objekt »anzustellen«. Die erste
Moglichkeit haben Sie bereits kennengelernt, als Sie den Quader nach unten ver-
schoben haben.

Die zweite Moglichkeit, ein Objekt zu drehen, brauchen wir jetzt noch nicht. Bei
einer Kugel sieht man davon nichts (es sei denn, das Licht dndert sich mit), bei
einem Quader schon.

1. Da sollten Sie gleich mal ausprobieren: Setzen Sie im INsPECTOR-Fenster unter
RotaTiON fiir Z z.B. den Wert 45 ein.

£ Scene @ Game © Inspector & i

| Elcenter v G@Local v || |1 ~E~-] & O @ 8 ~| |cube [ | statie =
- Tag Untagge~ Layer Defaul »

v /. Transform e i :
Positix 0 Y -4 Z.0o

otk

S®1 Y1 2

» B Cube(MeshFilter) @ =

» v MeshRenderer [ L
> &8 ~ Box Collider 9 3t !
Default-Material (Materi: @
Shader Stand~ Ed_lt e

| d

Add Compenent

Und schon wird der Wiirfel um 45 Grad gedreht.

Die dritte Moglichkeit der Transformation eines Objekts ist die Verinderung der
Mafle (Skalierung). Davon wollen wir jetzt Gebrauch machen. Denn der Quader
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sieht ein bisschen mickrig aus. Warum machen wir aus ihm nicht einen Balken,
der den ganzen unteren Spielfeldrand abdeckt?

2. Machen Sie zuerst die Drehung wieder riickgingig, dann indern Sie im INsPEC-
ToR-Fenster unter Scatk fiir X den Wert — mit einer Zahl zwischen 10 und 15.

# Scene o Game i @ Inspector 2 i
|| [Blcenter » @Local v || 1 rHE~-| © O @ @ vlcube | |swatc v
b Tag Untagged ~  Layer Default ~

v ).  Transform e i

Position X0 i -5 &0
Rotation X |0 B O Z 0
201

Scale éq 1
» B  Cube (Mesh Filter) [>]
» 5 v Mesh Renderer o
» &8 v Box Collider >} H
Default-Material (Material) e
Shader Standard - ﬂ | E v

Add Component

Damit ist der Quader sozusagen die Bodenplatte, auf die die Kugel fillt.

3. Speichern Sie nun die Szene, dann starten Sie das Spiel und schauen zu.

# Scene aB Game 3
e ‘ Stats |Gizmos A

| Game " Display 1 ~ |Free Aspect " Scale -@— 2x ‘Play Focused ~ | .‘|
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Ist das jetzt 2D oder 3D? Diese Frage haben Sie sich vielleicht schon viel frither
gestellt. Genau genommen haben wir es die ganze Zeit mit Objekten zu tun, die
dreidimensional sind. Da wir uns erst mal nur im 2D-Bereich (hier auf einer Fliche
mit Hohe und Breite) bewegen wollen, haben wir beim Erzeugen des Projekts die
2D-Ansicht eingeschaltet.

2D oder 3D

Man sieht das im Scene-Fenster an dem kleinen »eingedriickten« 2D-Button
(der liegt weiter rechts):

# Scene @& Game

|| [o] center v R Local v H -------------- -)‘ 2D IZD-Modus

# Scene a® Game

|| [Blcenter v @ Local ¥ |keemmemecsanes * 20 |3D-Mndus

Hier lisst sich die Anzeige zwischen 2D und 3D umschalten. Im 3D-Modus ist
die Anzeige 2D durchgestrichen.

Bei der Kugel sieht man den Unterschied nicht so stark, beim Quader schon, der
wird in 2D nur als blasses Rechteck dargestellt. (Wiirde man das Licht »ausschal-
ten«, dann wire die Kugel in 2D auch nur ein Kreis.)

Das klassische Koordinatensystem besteht normalerweise aus der x-Achse (Hori-
zontale bzw. Waagerechte) und der y-Achse (Vertikale bzw. Senkrechte).

Entlang der x-Achse geht es also nach links oder rechts, entlang der y-Achse nach
oben oder unten. Der Ursprung befindet sich genau in der Mitte. Der Punkt dort
hat die Koordinaten (0 | 0).
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Das ist auch in Unity so, doch weil Unity auch ein System fiir 3D-Spiele ist, reichen
keine zwei Achsen. Sondern es muss da noch eine dritte geben, z-Achse genannt.
An der entlang geht es nach vorn oder nach hinten.

Schaut man von vorn auf das Koordinatensystem, dann kann man diese Achse
nicht sehen. Um alle Achsen dennoch in 2D sichtbar zu machen, greift man zu
einem optischen Trick: Die z-Achse wird dann als Diagonale dargestellt.

Wenden wir uns wieder dem InspeEcToR-Fenster zu, dort sind ja unter TRANSFORM
alle drei Koordinaten aufgefithrt. Wenn man dort unter Position und ScALe z.B.
fiir den Quader den Wert hinter Z idndert, wird man bei 2D-Ansicht im ScENE-
Fenster nichts davon bemerken (aufler wenn bei Scare der Wert von Z = 0 wire).
In Wirklichkeit aber verschiebt sich der Quader nach hinten oder nach vorn oder
er dehnt sich in diese Richtungen aus.

Wenn Sie Lust zum Experimentieren haben, dann schauen Sie der Kugel noch
einmal beim Fallen zu, nachdem die »Bodenplatte« (bei gleicher Grofie) nach vorn
oder hinten verschoben wurde. Ergebnis: Die Kugel fillt weiter, weil sie ja nicht
mehr auf den Quader trifft.
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Y y Ergebnis
PosITION 0 0 1 Hinter der Kugel
RoraTION 0 0
SCALE 10 1 10 So lang wie breit

Sobald aber der Quader nach hinten und vorn ausreichend zu einer grofen Platt-
form vergroflert wird, bekommt die Kugel wieder »Boden unter den Fiilen«.

Transformationen mit der Maus

Wie man ein Objekt mit der Maus verschiebt, wissen Sie ja im Prinzip. Aller-
dings ist dazu eine bestimmte Einstellung nétig. Sie finden links oben im Scene-
Fenster oder direkt unter dem Hauptmenii eine Reihe von Buttons.

# Scene a5 Game

| Blcenter v @rocat~ (B0 <+ ¢5 & 11 &)

Dariiber kann man Objekte mit der Maus verschieben (Position-Modus), die
Grofe dndern (Scare-Modus) oder das Objekt drehen (RotaTioN-Modus).

Die Umschaltung geht auch mit den Tasten [W] = Verschieben, = Drehen,
(R] = Skalieren.

# Scene m Rama 'Q\(_e'rlayggnu -
Overlay Menu Enable Overlays
H e I e l Default -
: Maximize ==
Close Tab ® Tool Settings
Add Tab > || < ©ndand Snap
® Draw Modes
Ul Toolkit Live Reload @ \liew Options
Ul Toolkit Debugger  Ctrl+F5 ~~ Search
Binding Console Logs » | [ = Orientation
~ Cameras
Al Navigation
~ Overlay Menu
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Falls Sie diese Buttons mal nicht finden oder sehen, lassen sie sich so wieder-
herstellen: Klick mit der rechten Maustaste auf den Scene-Reiter, im Menii den
Eintrag OVERLAY-MENU und dann im nichsten Menti auf Toots.

Auch wenn wir fiirs Erste im 2D-Bereich bleiben werden, kann es nicht schaden,
mal einen genaueren Blick auf die 3D-Ansicht zu werfen.

1. Klicken Sie oben (rechts) auf die Schaltfliche 2D.

# Scene as Game

|| [ center v ERLocal ¥ |[feemsmmeeneens .ﬂ 20 lZD-Modus

# Scene am Game

|| [Blcenter v R Local ¥ |[femsmmmnmenes -D‘ 20 |3D-Modus

Die 3D-Ansicht der Szene hatten wir ja weiter oben schon mal. Man sieht die Kugel
nicht in der Mitte liegen. Die Kamera schaut aus einiger Entfernung von weiter
hinten zu. Beim Quader, den ich »Bodenplatte« genannt habe, sieht man die Aus-
dehnung in die Tiefe. Und ganz oben rechts wird die aktuelle Perspektive ange-
zeigt.

# Scene s Game

| Bcenter v @uocal> |1 [t~ © O @&~ (%) #x i@ =v m~

Quader

Um das Ganze auch mal im Game-Fenster zu sehen, miissen wir die Kamerasicht
im InspecTOR-Fenster umschalten.

2. Markieren Sie dazu den Eintrag MaIN CamERa links im HiEraArcHY-Fenster.
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5= Hierarchy & i ## Scene @ Game

o &) || Blcenter v Qlocaiv [T IR B ]| © © @ Ll &k~ »

) Directional Light

= Project B Console @ Unity Version Control

Wiirde ich jetzt ins Game-Fenster umschalten, wire dort aber noch immer die 2D-
Ansicht zu sehen.

3. Deshalb klicken Sie jetzt rechts im InspEcTOR-Fenster hinter ProjecTion auf
OrTHOGRAPHIC. In dem kleinen Zusatzmenii wihlen Sie den Eintrag PERSPEC-

TIVE.
© Inspector &
@ +| Main Camera | Static ~
- Tag MainCamev | Layer | Default «
» /. Transform [ L
¥ Wi v Camera @ 3
Clear Flags Solid Color hd
Background I
Occlusion Culling Everything -
Projection Orthographic -
Slas | ~  Perspective I
Clipping Planes Orthographic

4. Wechseln Sie nun zum GawmE-Fenster, dann sieht man den kompletten Boden.
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H# Scene o® Game
|Game * | Display1 ~ |Free Aspect > | Scale — 1.3x |Play Focused ~

Allzu toll sieht es nicht aus, auch weil alles nur weif8 bis grau auf blauem Hinter-
grund zu sehen ist.

5. Nicht nur deshalb sollten Sie wieder auf die OrRTHOGRAPHIC-AnSsicht zuriickge-
hen. Denn wir bleiben ja erst einmal im 2D-Bereich.

1.5 Ausblick

Unser erstes kleines Projekt ist damit fertig. Nichts Besonderes, aber auch nicht
tibel fiir den Anfang. Zuletzt sollen Sie noch wissen, wie man den Spiel-Objekten
einen anderen Namen geben kann. Dazu muss das jeweilige Objekt im HIERAR-
cHy-Fenster markiert sein.

6. Markieren Sie das jeweilige Objekt im Hrierarchy-Fenster, zum Beispiel
SpuERE. Dann driicken Sie die Taste [F2].

= Hierarchy Es = Hierarchy Ehgs = Hierarchy 2 i
*r (o B | [ B | &
v 1 Kugel1* ; v i Kugell* ; v P Kugell*
- = - -

) Main Camera

LT LIV i

&0 Sphere

{71 Directional Light f) Directional Light

Nun kann man durch direktes Neueintippen den alten Namen iiberschreiben. Bei
mir heifdt die Kugel nun »Kugel« und der Quader bekommt den Namen »Boden«.
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Speichern Sie dann am besten das ganze Projekt:

File
New Scene Ctrl+N
Open Scene Ctrl+0O
Open Recent Scene
Save Ctrl+S
Save As.. Ctrl+Shift+S
Save As Scene Template...
New Project...
Open Project...

I Save Project

Build Settings... Ctrl+Shift+B
Build And Run Ctrl+B
Exit

Und damit wird es Zeit, Unity erst mal wieder zu verlassen.

7. Dazu klicken Sie auf F1e und dann auf Exit. Oder Sie klicken im Hauptfenster
ganz oben rechts auf das kleine X — wie auch bei anderen Programmen tiblich.

File
New Scene Ctrl+N
Open Scene Ctrl+O
Open Recent Scene
Save Cirl+S
Save As... Ctrl+Shift+S
Save As Scene Template...
New Project...
Open Project...
Save Project
Build Settings... Ctrl+Shift+B
Build And Run Ctrl+B

| Exit

Damit wire eine Verschnaufpause fillig. Sie wissen nun schon, wie man ein (klei-
nes) Projekt erstellt und dass dies aus mindestens einer Szene und einem Spiel-
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Objekt besteht. Und Sie wissen auch, wie man ein Objekt erzeugt (itber GaAMEOB-
jEcT) und eine Komponente hinzufiigt (itber CoMPONENT).

Hier nochmal einige wichtige Elemente eines Spiel-Projekts im Uberblick:

GAMEOBJECT  Spiel-Objekt, wie z.B. Quader oder Kugel, aber auch Kamera oder Licht
COLLIDER Komponente fiir Kollisionen
RicipBopy

Komponente fiir physikalische Eigenschaften, wie z.B. Masse oder Gravi-
tation

Fiir jedes Objekt gibt es eine Transformations-Komponente mit diesen Optionen:

TRANSFORM Komponente fiir Anderungen der Lage und GréRe
PosiTioN Verschieben in alle Richtungen (3D)

RoTATION Drehen in alle Richtungen (3D)

SCALE

Vergroflern/Verkleinern in alle Richtungen (3D)
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